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Audio interface and control surface

This section explains how to set up and use the functions of the R16 audio interface and

control surface with DAW software installed on your computer.

Functions of the audio interface and control surface

[INPUT 1-8] jacks
Guitars and other
musical instruments,
internal stereo mic #

[PHONES] jack
Playback device like
headphones or an
audio system

o 0 [OUTPUT] jacks
Stereo system,

speakers with built-in

amplifiers, etc.

USB Cable

DAW software

Cubase LE, etc.

Audio driver

W Audio interface

The various input and output jacks of the
R16 can be used as a Hi-Speed USB (USB
2.0) audio interface with support for 8 ins
and 2 outs and input and output quality up
to 24-bit/96kHz. Effects can also be used
when the sampling rate is 44.1 kHz, and
the unit can be powered by the computer’s
USB bus.

W Control surface functions

The on-board control surface functions can
be used to control DAW software on your
computer via USB. Transport operations,
including playback, recording and stopping,
and physical control of the DAW faders
are possible. Furthermore, various other
DAW software functions can be mapped
to the F1~F5 keys. (The available functions
depend on the DAW software used.)
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W Supports input from a variety
of sources, including guitars,
mics and line level instruments.
The 8 onboard jacks, which accept XLR
and standard phone plugs, include one
high-impedance input and two with 48V
phantom power. From high-impedance
guitars and basses to dynamic and
condenser microphones and line-level
devices like synthesizers, many sources are
supported. In addition, the built-in high-
performance condenser microphones are
convenient for recording acoustic guitar and
vocals.

H Versatile effect functions

The insert effect can be applied to specific
channel paths and the send/return effect
works via the mixer send/return. The two
kinds of built-in effects can be applied when
recording, of course, but they can also be
applied to affect only the monitoring output.
For example, when recording vocals, you
can apply reverb to the monitor signal to
make singing easier, but record a dry signal.

B Comprehensive built-in mixer
Using the R16’s mixer, you can make a
mix for monitoring live and playback. When
simultaneously recording guitar and vocals,
for example, you can independently adjust
volume balance, panning and reverb levels.

B Multifunction tuner

In addition to standard chromatic tuning,
the multifunction tuner also has on-board
support for 7-string guitar, 5-string bass
and various drop tunings.




R16 audio interface system environment

To use DAW software with this unit, you need to install it and make settings in it for the R16. This is an expla-
nation for doing so with Cubase LE.

R16 audio interface system Cubase LE installation guide
requirements

Please refer to the Cubase LE Startup Guide for

Windows detailed instructions for installing the R16 audio

Windows® 7 (32-bit, 64-bit) or later driver and Cubase LE.
32-bit: Intel® Pentium® 4 1.8 GHz or faster

64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster

32-bit: RAM 1 GB or faster

64-bit: RAM 2 GB or faster

Intel Mac

OS X 10.9 or later
Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

Both
USB 2.0 compatible port

* USB hubs are not supported.

About the screen images
The screen images are of the Windows version.

About trademarks

- The SD symbol == and SDHC symbol are trademarks.

- Windows®/ Windows 7° are trademarks or registered trademarks of Microsoft®.
- Macintosh® and Mac OS® are trademarks or registered trademarks of Apple Inc.
- Steinberg and Cubase are trademarks or registered trademarks of Steinberg Media Technologies GmbH Inc.
~Intel” and Pentium® are trademarks or registered trademarks of Intel Corporation.
MACKIE Control is a trademark or registered trademark of LOUD Technologies.
All other trademarks, product names, and company names mentioned in this documentation are the property
of their respective owners.
All trademarks and registered trademarks mentioned in this manual are for identification purposes only and are
not intended to infringe on the copyrighted properties of their respective owners.
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Connecting and disconnecting in audio interface mode

This is a brief overview of connecting and disconnecting when a computer is hooked to the R16
by USB cable. For details, please refer to the separately attached “Cubase LE Startup Guide”.

Connecting the R16 to the
computer for the first time

‘I Install Cubase LE DAW software
on the computer

2 Download the latest ZOOM R16 /
R24 audio driver from the ZOOM
website (see below).

3 Install the audio driver on the
computer.

Install/setup details
[ (& Reference: “Cubase LE Startup Guide” }

4 Connect the R16 to the computer.

[ R16 setup and connection )

5 Setup DAW software

( Device setup )

[U@ Reference: "Cubase LE Startup Guide" }

( Control surface setup (Mackie Control) P.7)

| NOTE

R16 setup and connection

Follow these procedures from the second time connecfing

UsB
] D Press [USB].
2 Select

Change

Press [Enter].
3 Verify.
Press [Enter].
4 Select “Continue.”
- Change
4 >

The ZOOM R16/R24 audio driver is essential
for using the R16 as an audio interface for DAW
software such as Cubase LE.

When downloading, follow the included instruction
guide to install correctly.

@ Please download the latest R16 audio
driver from Zoom Corporation’s website
at (http://www.zoom.co.jp).

| NOTE

Set the recording quantization (bit depth) of
Cubase LE or the DAW software that you are
using to 24-bit in order to achieve the best audio
quality when recording. (See the software manual
for how to make this setting.)



5

Connect the USB cable to the R16.

The [DEVICI‘E] USB indicator will light.

ost —— Uss|—— DEVICE

=Kzl

AUDIO INTERFACE

AUDIO INTERFACE icon binks

Connect the USB cable
to the computer.

[ -

When connection is complete the AUDIO
INTERFACE icon appears.

AUDIO INTERFACE Connection setting
complete

Disconnecting

USB
] D Press [USB].

2 Terminate the connection.

‘ Press [Enter].

3 Remove the USB cable.

| NOTE

Data transferred with CONTINUE

- INSERT EFFECT settings

- SEND RETURN EFFECT settings

- Track parameter settings

- TUNER settings

RESET

Restores default settings for each item

- The audio interface and control surface functions
of the R16 can be used by drawing power
through the USB bus. Power from batteries or
the adapter is not necessary.

- We recommend always using the latest R16
system software. Operating the R16 with an older
system could result in it not being recognized by
your computer.
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Using the control surface functions

When using the R16 connected by USB as an audio interface, the R16 keys and faders can
be used to control Cubase LE’s transport and mixer.

About the control surface

Control surface settings

In control surface mode the keys and knobs on
the R16 can be assigned to particular Cubase
LE functions.

[ Transport section p.8 ]
[ About banks p.9 ]
[ Fader section p.9 ]
J HINT

Assigning Keys

For a list of functions that can be assigned to
the knobs and keys of the R16, as well as other
transport/function keys that are supported by
Cubase LE, please consult the “Control Surface
Mode Functions Quick Reference Guide” of this

manual.

[@ Reference: Control Surface Functions Quick Reference Guide ]

See R16 setup and connection
steps 1~6 on P.5~6.

7 Launch Cubase LE.

8 Select “Device Setup” from the
Cubase LE “Device” menu.

9 On the top left of the device
setup window there are [+] [-]
[I<] buttons. Click the [+] and
then choose “Mackie Control.”

‘IO Set MIDI input and output.

MIDI Input: Zoom R16_R24
MIDI Output: Zoom R16_R24

JHINT

The display of MENU etc. may be different
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.




Transport section

By setting up the control surface, the R16’s
transport section keys can be assigned to
individual functions in Cubase LE

[F1] Key [F2] Key [F3] Key [F4] Key [F5] Key

W"l"@ mlmﬂ f_ij [_.l..j mé@
N R )

CICCIC0C]

[REW] Key [FF] Key [STOP] Key [PLAY] Key [REC] Key
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Fader section operation

By using the faders and status keys of the R16 fader section, you can control the volume and
muting, pause recording and switch solo on and off in the corresponding Cubase LE tracks.

About banks

Operating the fader section

After setting up control surface operation, the
main parameters of Cubase LE can be operated
using the R16’s fader and status keys.

A group of tracks operated by the faders and
status keys is called a "bank," and one bank
includes 8 tracks.

For example, if fader 1 is assigned to Cubase LE
track 1, tracks 1-8 can be operated as shown in
the following diagram.

Control | 1 2 3 4 5 6 7 8
Track Tr1 Tr2 Tr3 Tr4 Tr5 Tr6 Tr.7 Tr8
As the diagram shows, pressing the [9~16tr
(Bank>)] key once switches the allocations as

shown below.

Control 1 2 3 4 5 6 7 8
Track | Tr9 Tr.10 Tri1 Tr.12 Tr13 Tr.14 Tr.15 Tr.16

1~8Tr

@ [1-8Tr] Key (< BANK)
Tracks (channels) assigned to the fader section

are moved backward by eight tracks.

9~16Tr

o [

@ [9~16Tr] Key (BANK >)
Tracks (channels) assigned to the fader section

are moved forward by eight tracks.

‘I Assign the desired Cubase LE
tracks (channels) to the fader
section.

2 Use the faders to control the

volumes of the corresponding
tracks.

The faders control the volumes of their
respective tracks. Change the master
volume by moving the [Master] Fader.



Press the MASTER track status key

to cycle through the functions of
the individual track status keys.

By pressing a track status key, you can
toggle solo, mute and record enable on

and off for the corresponding track.

MASTER/MIX DOWN/PLAY

e [

MASTER/MIX DOWN/PLAY

o []
REC/SOLO/MUTE

Each press of the

MASTER track key

changes the function in
mute>rec>so0lo order.

R16 level meters

MASTER

(audio interface use)

179
I
8716

Each level meter other
than the MASTER displays
the signal immediately
before sending it to the
computer.

MASTER

The mastering level
meter displays the re-
turning signal from the
computer.

Checking DAW recording levels

By setting “REC SIGNAL” to “WET” (signal with
effect) or “DRY” (no effect), you can send signals
to the computer with or without being processed
by the R16’s insert effects.

The recording levels of the sent signals are
displayed on the level meters. The signals shown
on the mastering level meter and each level meter
are different.

Please adjust the

-6—I—Red light level meter so

clippin that it does not
(clipping) light the red clip
m—f— indicator.
48— —

10
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1

Setting up function keys

The five keys above the transport keys can be used as function keys (F1~F5) and assigned
as you desire.

Function key setup method

1

Open the Device Setup Dialog
Box in Cubase LE.

Select Mackie Control

Commands can be assigned in the three
columns displayed on the right side of the
window.

From the (Button) column
choose the function key [F1~F5]
to be assigned a Cubase LE
function.

Click on the “Category” column
for that key.

Choose the type of Cubase LE
function from the Category pop-
up menu.

Click on the “Command” column
and select the desired specific
Cubase LE function from the
pop-up menu.

(The contents of this pop-up menu will
be different depending on the category
chosen.)

Press the “Apply” button.

J HINT

The display of MENU etc. may be different
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.




Control surface functions quick reference guide

Control | Explanation

12
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Using Cubase LE template files

Create a new project

‘I Copy the ZOOM R16 project
templates to the computer.

From the CubaseLE5_template folder on the CD
included with R16, copy the templates to the
location where Cubase LE is installed.

Windows

The folder opened by clicking Start>Steinberg
Cubase LE XX>User Settings Data Folder
Macintosh

/Applications/CubaselLE XX.app/Contents/
templates/

[ “XX” varies depening on the version installed.}

2 Launch Cubase LE and select File
> New Project.
Depending on your settings, either
the Steinberg Hub or the Project
Assistant dialog opens.

3 Create a new project

After copying the R16 project templates to the
designated folder, the R16 project templates will
be displayed when creating a new project.

By choosing these templates you will be able to
easily create projects with audio track input and
output settings arranged for the R16.

Template names and details

ZOOM R16 8Mono Recording

A project with Cubase LE monaural tracks 1~8
assigned to R16 [Input] 1~8

ZOOM R16 4Stereo Recording

A project with Cubase LE stereo tracks 1~4
assigned to R16 [Input] 1/2 ~ 7/8.

ZOOM R16 4Mono 2Stereo Recording

A project with Cubase LE monaural tracks 1~4
assigned to R16 [Input] 1~4 and Cubase LE
stereo tracks 5~6 assigned to R16 [Input] 5/6
and 7/8.

Tips to improve

performance

When using Cubase LE, the application’s
actions could become extremely delayed
or error messages such as “cannot
synchronize with USB audio interface” might
be displayed. Should such occurrences
become frequent, taking the following
measures might improve the situation.

O Terminate other running
programs.
In particular, confirm that there
are not a large number of background
applications running.

® Reduce the use of plug-ins in
Cubase LE (effects, sound
generator plug-ins)
If there are a large number of plug-
ins running, the computer might be
struggling to keep up. In addition,
reducing the number of simultaneous
playback tracks might be effective.

© Use the R16 AC adapter

When devices draw power from the USB
bus, on rare occasions computer

Please increase the Audio Buffer Size in the
Device Setup>VST Audio System menu if
the sound breaks up.

Moreover, if the application performance
is extremely slow and regular computer
operation is affected, we recommend
disconnecting the computer from the R16
USB port and quitting Cubase LE once
before reconnecting the USB port and
reopening Cubase LE again.




The mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R16’s internal mixer. In
addition, you can adjust the balance of the internal mixer and the sound from the computer.

Volume, reverb send and pan

STEREO LINK

You can be adjust the REVERB SEND, PAN,
VOLUME and STEREO LINK settings as in
recorder mode.

Operation is the same as in recorder mode.
(Reference: OPERATION MANUAL P.37)

The PAN/EQ Menu

VOLUME

You can set the volume levels for INPUT 1~8 between
0~127 (increments of 1). 100 is the default.

This is the first menu item displayed when you push the
[PAN/EQ] key in audio interface mode.

SEND REVERB

You can change the reverb send levels for INPUT 1~8
from 0~100 (increments of 1) with 0 as the default (same
as in recorder mode).

Reverb only affects the monitored signal.

PAN (BALANCE)

You can change the pan for INPUT 1~8 between
L100~R100 (increments of 2) with C (center) as the
default (same as in recorder mode).

Trirwtl

Link even and odd numbered INPUTS to handle them
as a stereo pair.

LITHE On

On/Off with “Off’ as the default.

By setting up a stereo link, REVERB SEND, PAN and
VOLUME track parameters can be applied to even and
odd inputs simultaneously. The odd numbered fader
will be active (same as in recorder mode).

(Reference : OPERATION MANUAL P.20 )

[BALANCE]

In audio interface mode the balance of the

signals monitored from the inputs and the signals

returning from the computer can be adjusted
with the [BALANCE] knob.

BALANCE

Left Right

Only the signals

Only the DAW
from INPUT 1~g  JIASTRR s

DIRECT stereo signal

| NOTE

The R16 REVERB SEND, PAN, VOLUME and
STEREO LINK settings are all saved when you

terminate audio interface mode and can be used
again the next time by choosing [CONTINUE] when
you relaunch audio interface mode.

14
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Tuner

The R16’s tuner can be used in the same way as in recorder mode. For further details

please consult the OPERATI

ON MANUAL.

CHROMATIC TUNER
TOOL>TUNER>CHROMATIC

T00L
] D Press [TOOL].

Change

2 Select :

menu

4 >

Push [Enter].

3 Select tuner type.

o IC 44

4 >

Change
tuner type

Base Pi
Tuner Type

itch

©

4 >

Change
tuner type

\—Chord / Note

4 CHRD

©

Select the

Change the base pitch

base pitch

and tune the instrument.

L Displays the note closes
signal.

Displays whether the pitch is higher or
lower than the displayed note.

JHINT

- The default base pitch is 440 Hz.
- Tuners other than the chromatic tuner can be used.
(Reference : OPERATION MANUAL P.31)

| NOTE

Tuner settings are saved when you terminate audio

t to the input

interface mode and can be used again the next
time by choosing [CONTINUE] when you relaunch
audio interface mode.



Effects in audio interface mode

The R16’s insert and send return effects can both be used when the sampling wavelength is
set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

Insert effect

Send return effect (reverb)

As in recorder mode, select the insert location
and the insert effect algorithm, as well as the
effect patches to be applied to the recording
signal.

Insert effect menu

Select the insert location

You can set it for any INPUT from 1~8.

(Reference : OPERATION MANUAL P.49)

Apply the effect only to monitoring

If you set “REC SIGNAL” to “Dry,” the effect will only be
applied to the monitoring signal and will not affect signals
recorded in DAW software.

Fo, @ of
:Z=- L

(Reference : OPERATION MANUAL P.55)

When in audio interface mode reverb can only
be used for monitoring. As in recorder mode,
you can use the [SEND RETURN EFFECT] menu
to change the patch and the [PAN/EQ] menu to
set the send level that adjusts the depth of the
reverb signal.

Send return effect menu
REVERB SEND

By altering the send level of the REVERB you can adjust
the depth of the added signal.

In audio interface mode the [SEND RETURN
EFFECT] key opens the “SEND REVERB” menu,
which is different from the recorder mode.
(Reference: Printed Manual P.35~45)

(Reference: Audio Interface Manual P.25)

| NOTE

- Effects can only be used when the sampling rate
is 44.1 kHz. At all other times it is turned OFF.
- Insert and send return effect settings are saved

when you terminate audio interface mode and
can be used again the next time by choosing
[CONTINUE] when you relaunch audio interface
mode.

16
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Working with patches

After you have made many edits, you might want to restore pre-edited settings by initializing the
patch. This will return it to its factory preset condition.

Patch operations
For both insert and send return effects

Patch operation menus

Select an insert effect or send return
effect patch

Press either INSERT EFFECT or SEND RETURN
EFFECT and select a patch from an algorithm.
(Reference: OPERATION MANUAL P.48)

Patch editing and renaming (EDIT)

By adjusting the effect module parameters you can set
it to create the desired result. You can also change the
name.

(Reference: OPERATION MANUAL P.53)

Importing patches (IMPORT)

All algorithms (as well as reverb patches) from the
effects of the project selected on the R16 can be
imported and saved as a single patch.

(Reference: OPERATION MANUAL P.54)

*In the audio interface mode, one complete set of effect
data is saved for the mode. There are no project based
settings.

Saving patches (SAVE)

Adjusted patches can be saved.
(Reference: OPERATION MANUAL P. 53)

Initializing patches (INITIAL)

Restores patches to their original factory settings (only
available in audio interface mode).

JHINT

Even if you have not imported patches the initial

settings of patches that were used in the recorder
mode can be used.

Patch initialization (factory reset)

EFFECT> select patch> PATCH INITIAL

INSERT EFFECT SEND RETURN EFFECT
] Press

O e 0O
Turn EFFECT On if Off

If “EFFECT Off" is displayed,

press [ENTER].

2 Select algorithm/patch.

B

v

Change
menu

VI

4 >
Change
menu

Insert effect example

Change

Send return effect (only reverb) example menu

Press [ENTER].

Confirm.

5

Press [ENTER].
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Cubase LE Startup Guide

@ Install Cubase LE referring to the bundled @ Select "New Project" from the "File" menu.
' ' CUBASE LE
Download access code sheet'. @ DOWNLOAD INFORMATION

"Project Assistant" window opens in order to select a project template. Click "More",
select "Empty", and then click the "Create" button to display the project window.

Toguir of Cubase L5
Culbase LE dowslsad insluctions
— G

(- Cubase Elzments 7 - [Cubase Elments 7 Praject - Untitied 1 [
‘\' File Edit Project Audio MIDI Media Transport Devices Window Help Steinberg Hub & x

@ Download the latest driver from ZOOM website
(www.zoom.co.jp) and install it.

Connect the ZOOM unit to the computer. R
Please refer to Operation Manual how to connect. XXX XXX - XXHEX-XXHXK - XHXHK

(@ steinberg

Download access code sheet

@ Select "Add Track">"Audio" from "Project" menu and add new audio track.

Startup Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio s Ty
system" in the Devices Column.

@ Select the downloaded driver or the devices including the ZOOM model names here.
e.g. H Series Multi Track is shown as following.

. MIDI Port Setup

CLICES OFF

QISR TRACK
Select "VST Connections" from "Devices" menu and set the input and output device L SN T
@ ports to the downloaded driver or the devices including the ZOOM model names. / l \
For multi-track supported models, click "Add Bus" and add the input bus.
e.g. H Series Multi Track is shown as following.

Stop button Play button Record button

Recording starts. Click "Stop" button to stop recording.

@ Click "Play" button to check the recording.

ZOOM H Series Multi Track ASIO
:|DOM H Series MultiT... IN L L . )
JOOM H Series Multi T... IN R This is all for the basic setting.
Sterea \| ZOOM H Series Multi Track ASIO For more information, pl refer to the Documentation from "Help" in Cubase LE or
O M T T visit Steinberg website (www.steinberg.net/en/home).
ZOOM H Series Multi T...

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.
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